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Preface

VBrick's EthernetTV-STB Set Top Box is a leading-edge digital set top box that provides a
low-cost standalone decoder for high-quality MPEG-1, MPEG-2, and MPEG-4 video assets.
It's an ideal MPEG decoder for cost-sensitive installations that require large-scale
deployment. The user-friendly set top box is controlled like a cable TV receiver using an IR
remote control. It can be used to access live streams, to request stored content from a video-
on-demand servet, ot to access the Web. The STB is a component in VBrick's EtherneTV
Media Distribution System. Other key components include:

* EtherneTV Portal Server — The ETV Portal Server is a video portal, permitting end
users to view live and on-demand MPEG-1, MPEG-2 and MPEG-4 and other streams
on a PC, Macintosh, or set top box.

* EtherneTV Video-on-Demand Servers — Provides all standard video-on-demand
(VoD) features including support for MPEG-1, MPEG-2, and MPEG-4.

*  VBrick Hardware Encoders/Decoders — Rugged, reliable video appliances that can
reside anywhere on your network to provide either distributed or high-density centralized
encoding/decoding of MPEG-1, MPEG-2, and MPEG-4 video.

Organization

Installation — provides an overview of the EtherneTV Media Distribution System and
instructions for initial STB setup and configuration.

Configuration — explains how to login and how to set customizable configuration parameters
for your particular environment.

Local Configuration — explains how to modify the xml file used when the STB is configured
for Local mode. In Local mode, the program listings are hard-coded in an XML file.

System Upgrade — explains how to download and install software when there is updated STB
code available from VBrick.

Serial Port Passthrough — explains how to use the serial port to control external devices such

as cameras or networked devices.

Using the Set Top Box — explains how to get started using the system. It explains how to
navigate, how to use the interface, and other basic STB concepts.

Font Conventions

Arial bold is used to describe dialog boxes and menu choices, for example: Start > All
Programs > VBrick

Courier fixed-width font is used for code elements (C++, HTML) as well as
filenames, directories, etc.

Bold Courier fixed-width font is used to indicate user input in keyboard
commands, scripts, etc.

Web addresses are displayed as hyperlinks in the format: http://www.VBrick.com

Iralics are used to emphasize specific words or phrases.
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Related Documents

vi

The following documents describe key components in VBrick's EtherneTV solution.

EtherneTV'-STB Quick Start Guide
EtherneT1-STB Release Notes

Etherne TV Portal Server User Guide
Etherne TV Portal Server Admin Guide
EtherneTlV-NXG VOD Quick Start Guide
EtherneTV-1"0D W Quick Start Guide
EtherneTV-170OD WM Quick Start Guide
VB4000-5000-6000 Administrator Guide
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Chapter 1

Installation

Overview

EtherneTV Media Distribution System provides the ability to view live streams and stored
assets directly on a television or monitor by using the EtherneTV-STB Set Top Box decoder.
The EtherneTV Set Top Box is integrated with the EtherneTV Portal Server and the
EtherneTV-NXG Video on Demand server to enable viewing of MPEG-1, MPEG-2 and
MPEG-4 pre-recorded and live streams. The EtherneTV-STB can also be deployed as a
standalone decoder without the need for an MCS. The STB can be configured to operate in
one of three modes: MCS, Local (standalone), Local-Fullscreen (standalone). See Start Mode
on page 10 for details.

When the installation of set top boxes includes an ETV Portal Server, the set top box is
directed to the portal server for user control; the graphics and user interface reside on the
ETV Portal Server. When the set top box is deployed independently of the portal server, it
comes equipped (in local mode) with a user interface and internal graphics. The Set Top Box
can be configured through a web browser on a PC in either Local mode or MCS mode.

Topics in this chapter

Overview
Using the Command Prompt
Initial Setup
x " EthermneTV-NXG
Live video feed Video On Demand
- OVD player
L
‘ -
T
) 4 oo cmo |
VBrick MPEG-1,2 & 4 /— EtherneTV-MCS VBrick MPE:I}- 1,284
encoders 1P Network Media Control Server encoders
é I
- Users with desktop
Users with laptops b 4 w computers running
running StreamPlayer StreamPlayer
~ VBrick MPEG-1,2 &4 EtherneTV-STB r
= decoders Set Top Box with remaote control =
Television Television

Figure 1. Ethernet-TV Media Distribution System
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Using the Command Prompt

You can use a Command Prompt interface to quickly perform a variety of tasks related to
STB configuration and connectivity using the pman configuration utility. There are three ways
to open a Command Prompt interface on the STB. Use whatever method is comfortable and
available. Once connected, they all work the same way. You can use:

*  Wireless keyboard — Type Ctrl-Alt-F1 to access the command prompt using the wireless
keyboard (or a standard keyboatrd connected to the PS/2 port); type Ctrl-Alt-F2 to exit.

* Terminal emulation — Connect a terminal (or a PC running terminal emulation
software) to the serial port; refer to Serial Port Passthrough for pinout details. Noze that
you cannot modify serial port parameters using this method. VBrick recommends using
Hyperterminal Private Edition 6.3 from Hilgraeve. (The configuration utility works
pootly using the Hyperterminal application shipped with Windows.) When using
Hyperterminal as a terminal emulation program, configure as follows:

1. Open Hyperterminal and go to File > Properties > Settings.

. Set "Function, arrow, and control keys act as" to Terminal Keys.

. Set Emulation to VT220 or VT320.

. Configure 25 rows by 80 columns.

. Set Terminal Mode to Cursor keypad mode.

2
3
4. Click the Terminal Setup button.
5
6
7

. Click OK twice when done.

*  Telnet — Connect to the STB from a PC running terminal emulation software. Vbrick
recommends using PuTTY version 0.56 Windows-based freeware or the standard Telnet
client shipped with RedHat Linux. (The configuration utility works poorly using the
Telnet client shipped with Windows or with Hilgraeve Private Edition 6.3).

Table 1. Common Command Prompt Actions

Command Prompt Action

Type

Reboot the STB

reboot -f

View Network Configuration

ifconfig

Edit the Local Ul
Configuration File

cd /wfs/localui
vi stbLocalUIData.xml

:q! (tO exit vi)

Test Network Connectivity

ping <ip_ address>

Clear the Screen

clear (ot Ctrl-L)

Change TV Resolution setres (see PAL Configuration on page 0)
File Transfer ftp
Get Current Software revision |tasteversion

Modify STB Configuration

pman — This program provides command line access to
the same configuration parameters as the management
interface described in the remainder of this document.
See Using pman below for a brief overview.

EtherneTV Media Distribution System
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Using pman

pman is an text-based configuration program that runs from the Unix shell on the set top box.
Its functionality mirrors the web-based configuration tool and you can use pman to set or edit
all STB configuration parameters. In a typical scenatio, you use a keyboard (wireless or PS/2)
to open a Unix shell and you launch pman from that shell. You can also run pman using
terminal emulation or Telnet.

v To run pman using the wireless keyboard:

1. Type Ctrl-Alt-F1 to access the Unix shell using the wireless keyboard (or a standard
keyboard connected to the PS/2 port).

At the VBrick-STB login: prompt, enter the username and password (root, admin).
Then type pman to launch the text-based pman configuration utility.

Navigate using the arrow keys; select fields or apply changes using the Enter key.

Select <. . . > to exit to a higher level in the menu.

SN

When done, type Ctrl-Alt-F2 to exit.

Initial Setup

The VBrick EtherneTV Set Top Box is shipped with Audio/Video, S-Video, and power cables,
and a handheld IR remote control unit. (An optional wireless keyboard is also available from
VBrick.)

Table 2. STB Front Panel — Left to Right

Infrared Sensor Above LEDs. Used for IR remote control and wireless keyboard.
Waiting Blinks red during initial start-up.

Transfer Blinks white when accessing flash memory.

Power Steady green when power is applied.

On/Off On/OAf push button.

Table 3. STB Rear Panel — Left to Right

Power Plug Connects to power cord.
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VGA Port

Used to view video on a VGA monitor.

Serial Port

Used for Serial Port Passthrough or to open a command line window.

PCI Card Slot

Not used.

S-Video Connect to standard TV.
Video Composite video out.
Audio Left/Right | Audio out left and right.

USB Ports (2)

Connect USB mouse and/ ot keyboard.

SPDIF Digital audio. Not supported.
LAN1 Connect to local area network.
LAN2 Not used.

PS/2 Connect PS/2 keyboard or mouse.

Connecting to the Network

Vv To connect the set top box to a TV and the network using the cables provided:

1. Attach the set top box video-out to a TV using the left (yellow) connector or the S-Video
connectot.

Connect the set-top box audio out (left and right) to a TV.
Connect the set-top box to the network using the LAN1 port.

Connect power cord to a power source.

Setting the IP Address

You need to know the IP address (or host name) in order to run the web-based STB Admin
Configuration application. (If the host name is not available, either because it has not been
configured or because it is configured for retrieval by DHCP and the DHCP server has not
provided it, the STB will default to a host name based on its MAC address.) By default, the set
top box is configured for DHCP (Dynamic Host Configuration Protocol) and will
automatically retrieve an IP address from a DHCP server if present. If a DHCP server is not
available, you can configure the set top box with a static IP address. The STB is set to a
default IP address of 172.17.11.111 as a convenience. In most cases, this should be changed
to avoid conflicts. You can find this IP address using a keyboard connected to the PS/2 port
ot by using a terminal connected to the serial port as explained below.

Note By default, DHCP is used to retrieve a dynamic IP address for the STB. If you are
not using a DHCP server, you must configure the STB to use a static IP address; the

default static address is 172.17.11.111.

¥ To determine the STB IP address:

1. If a DHCP server is present, go to Finding the DHCP IP Address to determine the IP
address of your STB in DHCP mode.

2. 1fa DHCP server is not present, go to Assigning a Static IP Address to manually assign an
IP address other than the default.
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Installation

Finding the DHCP IP Address

v
1.

To determine the IP address of the set top box when configured using DHCP:

Connect a keyboard and TV monitor to the set top box and apply power. (Use the
optional wireless keyboard or a PS/2 keyboatd). Wait for the box to completely power up
before continuing;

Press Ctrl-Alt-F1 on the keyboard to open a command line window.

At the prompt type ifconfig and press Enter. This shows the IP address, the network
interface configuration, and other parameters.

Reboot by powering the STB on and off using Power push button on front of unit.

Note If DHCP is enabled and DNS via DHCP is configured to yes, the configured domain

searchlist and domain name servers are ignored. The DHCP server must provide
the IP address of the DNS server for host name resolution to work propetly. If the
DHCP server does not supply a default domain or domain searchlist, fully qualified
domain names must be used wherever an IP address or domain name is configured
(for example in the MCS Location, Receive Address, Local Ul location, or home
page location on the Video Setup configuration page).

Assigning a Static IP Address

v
1.

A A o

*

10.

11.

12.

13.

14.

To assign a static IP address using a command line window:

Connect a keyboard and TV monitor to the set top box and apply power. (Use the
optional wireless keyboard or a PS/2 keyboard). Wait for the box to completely power up
before continuing;

Press Ctrl-Alt-F1 to open a command line window.

To enter the setup program, type pman and press Enter.
Select Parameters (using the arrow keys and Enter).
Select Network > Ethernet.

Change DHCP Enable to Static

When prompted, enter the default (case sensitive) User name and Password: root and

admin
Click Enter to reach OK and then click Enter.
Change DNS via DHCP to No.

Change Hostname via DHCP to No. For entries indicated with an asterisk (*), use the
arrow keys to move the cursor to the correct entry and use the spacebar to select the new
option.

Select IP address using the down arrow and the Enter key. Using the keyboard, enter the
IP address obtained from your network administrator and press Enter.

Select and enter the NetMask, Gateway addresses, and Hostname using the same
procedure as selecting the IP address above.

Leave the Ethernet interface Mode of operation at the default Auto (auto-negotiate).
(Other options are selectable but in most networks you should only select a different
option if necessary to interoperate with your network equipment.)

Enter the IP address of the Nameserver as follows:

a. Select Network (using the down arrow and the Enter key).
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b. Select Network again.

c. Select Domain NameServer IP Addresses and enter the Nameserver IP addresses. (If
there is more than one, separate the entries with the pipe character (|), for example
172.16.1.11]172.16.1.10.)

15. When done, use the up arrow key to reach <...> and select using the Enter key on each
screen. Answer Yes when prompted to apply changes and Exit to return to the user
prompt level. Wait until the changes are applied and the interface returns; otherwise the
changes may be lost.

16. Reboot by powering the STB on and off using Power push button on front of unit.

PAL Configuration

The setres command than can be executed from the Linux shell. This command lets PAL
users change the screen resolution. Although this command can be executed from the
Command Prompt or from Telnet, it is designed to be used from the serial port since a PAL
user without an NTSC or VGA monitor has no other choice if the STB IP address is
unknown. The syntax of the setres command is:

setres pal <username> <passwords>

setres ntsc <username> <passwords>

Model Numbers

The STB model number is shown on a label attached to the bottom of the unit. The
functionality in the following table is cumulative. The model at the bottom of the list inherits
all features and functions from the previous model. Any firmware is compatible with any
model; all models support MPEG-1, MPEG-2, and MPEG-4 streams.

Model Number Enhancements
8000-0044-0000 Base model.

8000-0044-0001 Improved MPEG-1 quality.
8000-0044-0002 Serial port added.
8000-0044-0003 Closed caption support added.
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Chapter 2

Configuration

Overview

The STB configuration application is used to change the default settings for the STB. Once
the IP address is obtained through the Command Prompt interface (see Setting the 1P
Address on page 4), you can access the set top box by typing the IP address into the Address
tield of a web browser, such as Internet Explorer. When the first page is displayed, select
Log in from the navigation bar at the top of the page.

Topics in this chapter
Overview

Configuration

Login
v To login to the set top box:

1. Enter the IP address of the STB in a browser and click Log in when the first page is
displayed.

{ (IJ . B B “ersion
‘ Configuration Login 03.71b

User name |
Password |

Start | Exi|

2. Enter the User name and Password and click Start. This displays the Administration
window. This window is used to access all system parameters. Most commands described
in this document are accessed via the Configuration button.

User name Default User name: root. Lower case, case sensitive.

Password Default Password: admin. LLower case, case sensitive.

STB Admin Guide 7
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Log out System Infarmation Systern Time Systemn Update Configuration

Administration

“ersion

Administration 0371b

Logout

Exits the configuration application.

System Information

Provides system-level information including version number,
networking configuration, and memory usage. Note that the version
number is shown in the upper-right corner of each window.

System Time

Use to set system time.

System Update

Use to update the software. See System Upgrade on page 27.

Configuration

Use to set all configuration parameters described in this document.

Saving Changes

Once logged in you can navigate and change Configuration parameters as necessary. Each of
the configuration screens has the same options at the top. When done, click Apply to save any
changes you have made. Do not click Apply after each change.

Log out Apply

Refresh Exit

Log out Logs out the current user. You can log back in as a different user if
necessary.
Apply Saves any configuration changes.
Refresh Refreshes the window with the last saved information.
Exit Returns the Administration page from anywhere in the application.
Configuration

Once you are logged in, click Configuration to display the four sub-categories of

configuration settings

for the set top box. Note that the VBrick_Host_Name shown on the

EtherneTV Media Distribution System



Configuration

following screens is a configurable option; see Network Settings on page 14 for more

information.
(M Config Service on Vel
- 03.72b
VBrick-STB
Log out Apply . Refresh . Euxit
Configuration
Video Settings These settings generally relate to the video stream, for example Start

Mode, MCS Location, Receive Address, etc.

Network Settings | These settings include Network, Ethernet, and Management SAP
settings.

Display Settings These settings let you adjust the resolution of your monitot.

General Settings These settings include Serial Port, Security, System Update, etc.

Video Settings

(M Config Service on e
VBrick-STB
Log out Apply . Refresh . Exit
444 =

Configuration
* Start Mode
* MCS Lacation

* Receive Address

L

Local Ul Location
HomePage Location
HomePaige enable

Main volume

Line 1 volurme

* RTEP streaming

Data Buffering

Seconds

*  Buffer Check for

Underflow =

Start Mode
MCS Iocation
Receive Address
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Local Ul Tocation

Home Page Location/Home Page Enable

Main Volume/Line 1 Volume

RTSP Streamin:

Data Buffering Seconds
Buffer Check for Underflow

Lowest Bitrate for Buffer Check
Audio Data Port/Video Data Port/CC Data Port
RTP Data Port

Proxy Type, HT'TP Proxy Host and Port

Options Panel Login
Aux1-Aux8

Start Mode

The EtherneTV STB can operate in one of three modes described here. Use MCS mode if
there is an ETV Portal Server (formerly MCS) installed on your network. Otherwise you must
select Local or Local-Full Screen mode.

MCS Use if the installation includes the EtherneTV Portal Server.

Local Use if the installation does not include the EtherneTV Portal Server.
If Local, the site administrator must configure the Program Guide. See
Local Configuration on page 21 for more information.

Local-Fullscreen | Use if the desired operation is to set the unit to decode one channel
and operate in full screen mode at boot up. If you select Local-
Fullscreen mode, yon must also enter a Receive Address; see below.

MCS Location

MCS Location When the start mode is configured for MCS, this parameter
determines the IP address of the ETV Portal Server that the STB will
obtain its program listing information from. Enter the IP Address of
the portal server. The formatis 172.12.12.12.

Receive Address

Receive Address When the Start mode is configured for Local-Fullscreen, this
parameter determines the IP address of the stream to be decoded. The
choice of receive address/program info and stream type of the desired
video must be entered here and must follow the syntax examples
shown in Table 1, Receive Address Syntax. Note that you can use a
hostname or numeric IP address wherever an <ipaddrs is called for if
the hostname is entered in the local DNS server.

10 EtherneTV Media Distribution System
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Table 1. Receive Address Syntax

Multicast MPEG-1

RTSP@MULTICAST MPEGLl://group:port/

Multicast MPEG-2

RTSP@MULTICAST MPEG2 TRANSPORT://group:port/

Unicast or Multicast MPEG-4 with
Remote SDP File

http://<ipaddr>/<path_to_remote_ file>

Unicast or Multicast MPEG-4 with
Local SDP File

RTSP@ISMA SDP_FILE:///wfs/<path_to_local_ files,
€.g. RTSP@RISMA SDP_FILE:///wfs/mpg/currentmp4.sdp

See Local-Fullscreen Mode with MPEG-4 Multicast for
information on how to FTP the SDP file to the set top
box.

Unicast MPEG-1

RTSP@QUNICAST MPEG1://#dataPort=<ports>

Unicast MPEG-2

RTSP@QUNICAST MPEG2 TRANSPORT://#dataPort=<ports>

RTSP MPEG-1 for Video on Demand
(EtherneTV NXG only)

RTSP@KASENNA MPEGL1://<ipaddr>/program

RTSP MPEG-2 for Video on Demand
(EtherneTV NXG only)

RTSP@KASENNA MPEG2 TRANSPORT://<ipaddrs>/program

RTSP MPEG-1 for Video on Demand
(EtherneTV VoD-W only)

RTSP@INFOVALUE MPEGL://<ipaddr>/program

RTSP MPEG-2 for Video on Demand
(EtherneTV VoD-W only)

RTSP@INFOVALUE MPEG2 TRANSPORT://<ipaddr>/
program

RTSP MPEG-4 Internet Streaming
Media Alliance ISMA)
(Live or VoD)(

RTSP@ISMA://<ip addr>/program

(e.g. RTSP@ISMA://172.22.117.2/vbrickvideol --0f--
RTSP@ISMA://172.22.119.119/Complete-Movies/
enterprogramname)

Video can be streamed over UDP or TCP. See RTSP
Streaming on page 13 for options.

Local-Fullscteen Mode with MPEG-4 Multicast

Note If necessary you can FTP the SDP file to the set top box as described here.
However the recommended method is to retrieve the SDP file via HTTP.

To decode multicast MPEG-4 in Local-Fullscreen mode, you can put an SDP file on the set
top box using the set top box internal FTP server as shown in the sample FTP session below.

¥  To decode multicast MPEG-4:

1. First, obtain an SDP file for the MPEG-4 multicast stream. When streaming from an
MPEG-4 encoder, see the V'B4000-5000-6000 Administrator Guide for information

about SDP files.

2. Use an FTP client to place the SDP file on the set top box. A sample FTP session to use
an set top box with the IP address of 172.22.117.70 is shown below. (Server prompts are

shown in bold.)

STB Admin Guide
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c:\> ftp 172.22.117.70

User (172.22.117.70: (none)): root
331 Password required for root.
Password: admin

230 User root logged in

ftp> bin

200 Type set to I.

ftp> cd wfs/mpg

250 CWD command successful.

ftp> put vbsldl.sdp

200 PORT command successful.

150 Opening BINARY mode data connection for vbsldl.sdp
226 Transfer complete.

ftp: 739 bytes sent in 0.12 Seconds
ftp> bye

Local UI Location

Local UI Location | When the start mode is configured for Local, the STB will allow static
listings and previews of multiple channels on the network. You can
use this setting to create a custom user interface.

When the Start Mode is configured for Local, the STB will display static listings and previews
of multiple channels on the network. These listing are configured in an xml file. The xml file
must be modified for each network installation so that IP addresses, port numbers, encoder
types and program listings correspond to actual network settings. This file is edited for local
mode installations only and does not apply when operating in MCS or Local-Full Screen
mode. For detailed examples of how to edit the xml file, go to XML Configuration Examples
on page 23.

Home Page Location/Home Page Enable

Home Page This parameter determines the location of the home page that is
Location/Enable | displayed when the WWW button is pressed on the IR remote control.
When this option is disabled, the Home page will not be loaded when
the WWW button is selected.

Main Volume/Line 1 Volume

In MCS mode, when the volume has been manually turned down using the remote (and the
configured audio level is significantly higher), there will be a brief burst of higher volume
when switching views between preview and full screen. Reduce the configured audio level to
avoid abrupt changes in volume.

Main and Line 1 These parameters determine the initial volume level the STB will
Volume provide to the TV or monitor. Set both to same value. The volume can
be changed using the IR remote control but will revert to the
configured values at start-up.
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RTSP Streaming

RTSP Streaming

MPEG-4 streams in Local-Fullscreen mode only. Choose the protocol

for RTSP streaming. If the source is a video-on-demand server, yon must

¢hoose UDP.

* UDP — MPEG-4 RTSP streams will be sent over UDP.

* Interleaved (TCP) — MPEG-4 RTSP streams will be sent over TCP
on the RTSP port. (Also called "RTSP Interleaved".)

* Automatic — An attempt will be made to play the stream over UDP.
If this fails, TCP will be used.

Data Buffering Seconds

Data Buffering
Seconds

MPEG-4 only. This setting will allow more data to be saved before it is
displayed. This can be used in networks where there is a high amount
of delay variation or congestion in the network backbone, and will
'smooth out' video when the network has not been optimized. This
parameter should generally be left at the default value.

Buffer Check for Underflow

Buffer Check for
Underflow.

If checked yes, a periodic check for buffer underflow will be made
using the value in Lowest Bitrate for Buffer Check as a cutoff. Setting
a small value for Lowest Bitrate may result in disruption to low bitrate
MPEG-4 streams. This parameter should generally be left at the
default value.

Lowest Bitrate for Buffer Check

Lowest Bitrate for
Buffer Check

If Buffer Check is set to yes, and if video stream has bitrate greater
than the value, a periodic check for underflow for MPEG-4 streams
will be made. This parameter should generally be left at the default

value.

Audio Data Port/Video Data Port/CC Data Port

Audio and Video

Audio, Video, and CC Data Port settings default to 6970, 6972, and

Data Ports 6974 respectively. These are used to determine receive ports for data.
This will affect MPEG4 streams requested via RTSP. This will be used
only for MPEG-4 streams. The range is from 0 to 65534. The data
port must always be an even number.

RTP Data Port

RTP Data Port Set the data port number to use for RTP data. Default = 6970. 0 is

random. This will be used only for MPEG-1 and MPEG-2 streams
served by the VoD server. The range is from 0 to 65535.

STB Admin Guide

13



14

Proxy Type, HTTP Proxy Host and Port

Not used.

Options Panel Login

Not used.

Aux1-Aux8

Not used.

Network Settings

¥ Network
* Ethemet
> Management

(O Config Service on Versin
VBrick-STB
Log out Apply Refresh Exit
444

Configuration

Network

Ethernet

Management

Network

These options are used to change network-related settings. The FTP server is used to transfer
files to the STB from a remote device such as a PC.

FTP Server User Username used to log into the FTP server on the STB.
Name

FTP Server Password | Password used to log into the FTP server on the STB.
FTP Home Directory | Home directory of the FTP server on the STB.

Domain Name Server
IP Addresses

IP address (or addresses) of the DNS server. Separate multiple
DNS servers with a pipe character, for example:
172.16.1.10|172.16.1.11

Domain Searchlist

The list of domain names that will be searched when resolving
host names. Separate multiple domains with a pipe character (]).
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Ethernet

These options are used to enable or change the Ethernet settings on the STB. Some or all may
have been previously configured earlier. See Setting the IP Address on page 4.

Network DHCP To change to Static, select option

DNS via DHCP When using DHCP: If the DNS settings should come from the
DHCEP server, check the box (for yes). If not, uncheck the box
(for no).

Hostname via DHCP | When using DHCP: If the host name will come from the DHCP

server check the box (for yes). If not, uncheck the box (for no).

VBrick Hostname

Enter a hostname if Hostname via DHCP is set to No or if
DHCP enable is set to Static. If you enter an invalid host name,
the STB will not start. If no host name is entered, it defaults to the
MAC address. The following rules apply to host name:

* must less than 19 characters.

* first character must be a letter.

* last character must be a letter or digit.

* interior characters must be letters, digits, or hyphen.

* no embedded spaces or special characters are allowed.

1P Address If the IP address is static rather than set through DHCP, enter it
here.

Subnet Mask Set when using a static IP address.

Gateway IP Address Set when using a static IP address.

Network Interface

Set the Ethernet interface to the desired speed and duplex of

Speed-Type operation. Default is Auto (auto-negotiate) but 10Mbps and
100Mbps, half and full duplex options are selected if required.
You should only select a different option if necessary to
interoperate with your network equipment.

Management

The STB transmits Management SAPs for use by other VBrick devices and/or applications
on the network such as VBDirectory or MCS. This menu configures the transmission of these
management SAPs. These options are used to enable or change the management settings on

the STB.

Group Name STBs can be assigned to groups for more organized management.
This is the group name that the STB is associated with (for example
Finance).

Unit Number This value represents the specific STB ID when it is part of a group

(for example Finance, unit 33).

Transmit Enable | Enables transmission of the management SAP.

Retransmit Time | Determines how often (interval) the STB emits the management SAP.

STB Admin Guide
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Time to Live Determines the number of hops that a SAP will travel before being
discarded.

Type of Service The value of the TOS bits in the IP header of the management SAP
packets. This parameter can be used to implement quality of service
within a network.

IP Address Determines the unicast or multicast IP address that the SAP will be
sent to.
Port Determines the IP port that the SAP will be sent to.

Display Settings

(M Config Service on s
VBrick-STB
Log out Apply Refresh Bt
444
Display Configuration
¥ General
¥ Resolution
General
Resolution_
General

The options on this page (except for Splash Screen parameters) are not supported. A splash
screen showing the VBrick logo is briefly displayed when you power-on the system or reboot.
The Splash Screen parameter lets you replace the standard VBrick page with a customized
page. Note that a custom splash screen must be in the .xpm graphics format used in Unix and
cannot exceed 100 KB. Be sure to check the file size. ImageMagick is freeware available on
the web that can be used to convert a .jpg file to an .xpm. You can download the Windows
binary version of this application from http://sourceforge.net/project/
showfiles.php?group id=24099. After download, open a Command Prompt window and
type:

convert mySplash.jpg mySplash.xpm

You can also use the size parameter to change the resolution of the .xpm file. For example:

convert -size 160x120 mySplash.jpg mySplash.xpm

Show Version Choose whether the splash screen should show the version number.
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Splash Screen Choose the type of splash screen to display during startup:

* Default — Use the default VBrick splash screen.
* Custom — Use a custom splash screen.
¢ None — Use a blank screen.

Location of Custom | The location of custom splash screen. The image should be in the
Splash Screen xpm file format and less than 320 x 240 pixels in size. Place the
image in the /wts folder on the set top box.

Resolution

These options are used to enable or change the display resolution settings on the STB.

Color Depth Not used.

Decoder Video Format | Determines whether NTSC or PAL resolution is being used. Set
to match your TV.

General Settings

(M Config Service on ersion

VBrick-STB
Log out Apnly Refresh Exit
444

Configuration

» Serial Port ¢

P Security

P System

P Systern update

» Language

P Hardware

Serial Port

System
System Update
Language

Hardware

Serial Port

Using serial port passthrough, STBs can provide full duplex, end-to-end transparent
passthrough of user data from an STB to a VBrick, or to other networked devices. The STB
has one serial port that can be used for passthrough. The serial port operates at its configured
baud rate (e.g. 115.2 to 300K bps). Some common applications include remote control of a
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camera (pan-tilt-zoom), remote control of security doors, low speed data transport, or data
collaboration between PCs.

Passthrough:
Responder

If enabled, will be a Passthrough responder; else port will host a serial
shell fixed at (9600, 8N1).

Passthrough: Baud
Rate

Choose the Baud Rate for serial port when Passthrough is active.
Default = 9600.

Passthrough: Stop
Bits

Choose the number of Stop Bits for serial port when Passthrough is
active. Default = 1.

Passthrough: Parity

Choose the Parity for serial port when Passthrough is active. Default =
None.

Passthrough: RTS
Control

Choose the RTS control method for the serial port when passthrough
is active. Used to initiate an action when a signal is detected. See Serial
Port Pinouts on page 38 for more information.
* Force-Off (default) — Signal always off.
* Force-On — Signal always on.
* Automatic — Set to on when serial port passthrough is active; set to
off when not active.

Passthrough: DTR
Control

Choose the DTR control method for the serial port when passthrough
is active. Used to initiate an action when a signal is detected. See Serial
Port Pinouts on page 38 for more information.
* FPorce-Off (default) — Signal always off.
* Force-On — Signal always on.
* Automatic — Set to on when serial port passthrough is active; set to
off when not active.

Security

Root Password

Changes the password used to log into the STB when the username

iS root

User Password

Changes the password used to log into the STB when the username

iS noroot

Enable FTP Server

Check box to enable FTP setvet.

Enable Telnet Server

Check box to enable Telnet server.

Enable HTTP Server

Check box to enable HT'TP servet.

Enable Browsing

Check this parameter to allow access to external web pages and
allow use of the STB as a web browser.

System

The STB can be configured to automatically reboot at a specified interval.
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Watchdog Frequency Default = 0 which means never reboot; 1 means reboot every
day; 2 means reboot every second day, and so on. Watchdog
Time is used in conjunction with Watchdog Frequency.

Watchdog Time Choose time (on 24-hour clock) that this unit will restart.

Enable Gateway Validation

startup. Default = Enable.

Specifies whether the network gateway should be validated at

System Update

These parameters are used to set system update options. See System Upgrade on page 27 for
a description of this procedure.

FTP Server

The location of the external FTP server from which the STB will
access system update files.

Relative Directory
Path

Location of system update files on the external FTP server. For
example, if system update files are located in /user/r370 and the
home directory is /uset, then enter 370 in this field.

FTP User Username used to log into the external FTP server.

FTP Password Password used to log into the external FTP server.

Update Proxy Not used.

Update Proxy Port | Port used for the proxy server.

Always Full Updates | This option should always be checked. This option determines

whether or not partial or full updates should be performed.

Auto Check for
Update

This option should always be unchecked. It determines whether or
not the STB should check for code updates at initial startup.

Run Post-Update
Script

This option should always be unchecked.

Language

Not used. Do not change from factory defaults.

Hardware

The only user-selectable option on Hardware menu is Mouse Type. If you connect a USB
mouse to the USB port on back of STB, you must change this setting to USB or the mouse

will not work.
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Chapter 3

Local Configuration

Overview

When the Start Mode is configured for Local, the STB will display static listings and previews
of multiple channels on the network. These listing are hard-coded in an xml file. This xm!/ file
is used for Local mode installations only; it does not apply when operating in MCS mode or Local-
Fullscreen mode. (To select Start Mode in the web-based STB configuration application, go to
Configuration > Video > Setup > Start Mode.) Examples of the local xml file that contains
local mode program information are shown on the following pages. This xml file will need to
be modified for each network installation so that IP addresses, port numbers, encoder types
and program listings correspond to actual network settings available onsite.

When the Start Mode is set to Local, the STB user interface is defined by the local
administrator. The default location of the local user interface is on the STB in /wfs/localUI/
stbLocalUITemplate.htm. This HTML file and the other Javascript, XML, CSS, and image
files in /wfs/localUl are provided as a sample user interface that can be customized for your
specific requirements. (To change the location of the UI, go to Configuration > Video >
Setup > Local Ul Location.) The window below shows the interface page
(stbLocalUITemplate.htm) affer it has been modified with stream data.

EthernelV*

MEDIA DISTRIBUTION SYSTEM

LIVE

BSB-Martinez-200klo-1HR

BSB-Martinez-128klo-1HR ’
4

BSB-Martinez-200khi-1HR MESSAGES

Gl

BSB-Martinez-128khi-1HR

MPEG?2 multicast

Figure 1. Sample Interface in Local Mode
Topics in this chapter
Overview

Accessing the XMI. Configuration File
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XMI. Configuration Fxamples

Accessing the XML Configuration File

22

The "configuration" file refers to the xml file (/wfs/localUI/stbLocalUIData.xml) that
provides the list of streams available to the STB. This configuration file is used by
stbLocalUITemplate.htm to populate the interface page. The xml file can be edited locally
using a text editor (vi is included with the system) or it can be uploaded to a Windows
desktop, modified with Notepad, and downloaded back to the STB. Once the file has been
edited or created it must be installed on the STB. This is usually accomplished via FTP.

When editing the configuration file, do not use special characters or punctuation marks in any
text strings; if used in the Title, ProgramName, Message, etc., the stream will not run. Also, be
aware that it may take several seconds to write configuration changes to flash memory. To
avoid problems, wait several seconds and do not reboot the STB until the Transfer LED on
the front of the unit stops blinking,

Vv To access the command prompt and XML file:

1. Press Ctrl-Alt-F1.

2. Then cd (change directory) to the location: /wfs/localui/

Uploading from the STB

To FTP upload/download files from/to the STB (including the stbLocalUIData.xml
configuration file), you can use Internet Explorer, another GUI based FTP client, or the
command prompt FTP client using the following commands:

Vv To upload from the STB:

C:\> ftp 172.22.117.70

User (172.22.117.70: (none)): root
331 Password required for root.
Password: admin

230 User root logged in

ftp> bin

200 Type set to I.

ftp> cd /wfs/localui

250 CWD command successful.

ftp> get stbLocalUIData.xml

200 PORT command successful.

150 Opening BINARY mode data connection for ...
226 Transfer complete.

ftp> xxx bytes sent in 0.12 Seconds
ftp> bye

Downloading to the STB
v To download to the STB

C:\> ftp 172.22.117.70

User (172.22.117.70: (none)): root
331 Password required for root.
Password: admin

230 User root logged in
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ftp> bin

200 Type set to I.

ftp> cd /wfs/localui

250 CWD command successful.

ftp> put stbLocalUIData.xml

200 PORT command successful.

150 Opening BINARY mode data connection for
226 Transfer complete.

ftp: 739 bytes sent in 0.12 Seconds

ftp> bye

XML Configuration Examples

The following examples show how to modify the xml configuration file (/wfs/localUI/
stbLocalUIData.xml) for different media.

Title and Global Message Settings.

<?xml version="1.0"?>
<STBLocalUI>

<!-- this is general information -->
<Title>my STB Title</Title>
<GlobalMsg>Global Message</GlobalMsgs>
<DefChannel>2</DefChannel>
</STBLocalUI>

Example of live MPEG-1 multi cast entry with IP addtess, port number, and channel number.

<!-- this is MPEG1l live stream -->

<Stream type="MPEG1l">

<ProgramName>Sample MPEGl stream</ProgramName>
<Message>BSB-MPEGl stream</Message>
<Channel>1</Channel>

<IP>239.22.119.99</IP>

<Port>4444</Port>

</Stream>

Example of live MPEG-2 multicast entry with IP address, port number, and channel number.

<!-- this is MPEG2 live stream -->

<Stream type="MPEG2">

<ProgramName>Sample MPEG2 stream</ProgramNames>
<Message>This is CNN.</Message>
<Channel>2</Channel>

<IP>239.16.120.3</IP>

<Port>4444</Port>

</Stream>

Example of live MPEG-4 multicast entry with SDP addressing information.

<!-- this is MPEG4 multicast live stream -->
<Stream type="SDP">
<ProgramName>MPEG4 multicast-remote SDP</ProgramName>
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<Message>SDP file retrieved through HTTP</Message>
<SDP>http://239.22.133.3/vbs1dl.sdp</SDP>

</Stream>

Example of live MPEG-4 multicast entry with local SDP addressing information.

<!-- this is MPEG4 multicast live stream with SDP file stored locally-->
<Stream type="SDP">

<ProgramName>MPEG4 multicast-local SDP</ProgramName>

<Message>SDP file stored locally</Message>
<SDP>file:///wfs/mpg/mySDP.sdp</SDP>

</Stream>

Example of live MPEG-4 unicast entry with local SDP addressing information. Encoder must be
configured to unicast to STB’s IP adress.

<!-- this is MPEG4 unicast live stream with SDP file stored locally-->
<Stream type="SDP">

<ProgramName>MPEG4 unicast-local SDP</ProgramName>

<Message>SDP file stored locally</Message>
<SDP>file:///wfs/mpg/mySDP.sdp</SDP>

</Stream>

Example of live MPEG-4 stream with forced UDP streaming.

<!-- this is an MPEG4 rtsp stream (force UDP streaming)-->
<Stream type="RTSP4">

<ProgramName>MPEG4 RTSP (UDP)</ProgramName>
<Message>Sample MPEG4 RTSP (UDP streaming)</Message>
<Channel>3</Channel>

<IP>172.22.133.5</IP>

<RTSPName>vbrickvideol</RTSPName>

</Stream>

Example of MPEG-4 RTSP stream with forced RTSP interleaved (TCP) streaming;

<!-- this is MPEG4 rtsp stream (force RTSP interleaved(TCP) streaming)-->
<Stream type="RTSP4_ TCP">

<ProgramName>MPEG4 RTSP (TCP)</ProgramName>

<Message>Sample MPEG4 RTSP (Interleaved streaming)</Message>
<Channel>4</Channel>

<IP>172.22.133.5</IP>

<RTSPName>vbrickvideol</RTSPName>

</Stream>

Example of MPEG-4 RTSP stream with Auto selection streaming;

<l-- this is an MPEG4 rtsp stream (Automatic selection streaming) -->
<Stream type="RTSP4 AUTO">

<ProgramName>MPEG4 RTSP (AUTO)</ProgramName>

<Message>Sample MPEG4 RTSP (Automatic streaming)</Message>

<Channel>5</Channel>
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<IP>172.22.133.5</IP>
<RTSPNames>vbrickvideol</RTSPName>

</Stream>

Example of MPEG-1 unicast entry with port address.

<!-- this is MPEG1l Unicast stream -->

<Stream type="UNICAST MPEG1l">
<ProgramName>Sample MPEGl Unicast</ProgramName>
<Message>Sample MPEGl Unicast stream</Message>
<Port>5555</Port>

</Stream>

Example of MPEG-2 unicast entry with port address.

<!-- this is MPEG2 Unicast stream -->

<Stream type="UNICAST MPEG2_ TRANSPORT">
<ProgramName>Sample MPEG2 Transport Unicast</ProgramName>
<Message>Sample MPEG2 Transport Unicast stream</Message>
<Port>4444</Port>

</Stream>

Example of MPEG-1 content from NXG server with IP address and program name.

<!-- this is VoD content from MPEGl -->
<Stream type="VOD1">

<VODServer>172.22.119.118</VODServer> <!--vod server ip address or hostname-->

<ProgramName>MP1 RONIN</ProgramNames><!-- vod content name -->

<Message>MPEGl content on 172.22.119.118</Message> <!-- local message -->
<Location>Complete-Movies</Location> <!--fullpath for vod content location -->
<Durations>1hr59minS6sec</Duration> <!-- vod content duration --»>
<Keyword>MPEG1l stream</Keyword> <!-- vod content keyword -->

</Stream>

Example of RTSP MPEG-2 content from NXG server with IP address and program name.

<!-- this is VoD content from MPEG2 -->

<Stream type="VOD2">

<VODServer>172.22.119.118</VODServer> <!--vod server ip address or hostname-->
<ProgramName>LOTR-The-Two-Towers</ProgramName> <!-- vod content name -->

<Location>Complete-Movies</Location> <!--full path for vod content location-->

<Message>MPEG2 content on 172.22.119.118</Message> <!-- local message -->
<Duration>2hrs52mins30sec</Duration> <!-- vod content duration -->
<Keyword>MPEG2 stream</Keyword> <!-- vod content keyword -->

</Stream>

Example of MPEG-4 content from NXG server with IP address and program name.

<!-- this is VoD content from MPEG4 -->
<Stream type="VOD4">
<VODServer>172.22.119.118</VODServer> <!--vod server ip address or hostname-->

<ProgramName>Bad-Boys-2-V1l</ProgramName> <!-- vod content name -->
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<Location>Complete-Movies</Location> <!--full path for vod content location-->

<Message>MPEG4 content on 172.22.119.118</Message><!--local message-->

<Durations>2hr26mins58sec</Duration> <!-- vod content duration -->
<Keyword>MPEG4 stream</Keyword> <!-- vod content keyword -->
</Stream>

Example of MPEG-1 content from VoD-W setrver with IP address and program name.

<!-- this is VoD content (MPEGl) from Infovalue -->

<Stream type="VOD1I">

<VODServer>172.17.17.5</VODServer> <!-- vod server ip address or host name -->
<ProgramName>MPEG-1InfovalueVODfile</ProgramName> <!-- vod content name -->
<Message>MPEGl content on Infovalue</Message> <!-- local message -->
<Location>/</Location> <!-- full path for vod content location -->
<Duration>1h 59m 56s</Durations> <!-- vod content duration -->

<Keyword>Mpl stream</Keyword> <!-- vod content keyword -->

</Stream>

Example of MPEG-2 content from VoD-W server with IP address and program name.

<!-- this is VoD content (MPEG2) from Infovalue -->

<Stream type="VOD2I">

<VODServer>172.17.17.5</VODServer> <!-- vod server ip address or host name -->
<ProgramName>MPEG-2InfovalueVODfile</ProgramName> <!-- vod content name -->
<Location>/</Location> <!-- full path for vod content location -->
<Message>MPEG2 content on Infovalue</Message> <!-- local message -->
<Duration>1h Om Os</Durations> <!-- vod content duration -->
<Keyword>Mp2 stream</Keywords> <!-- vod content keyword -->
</Stream>

Example of MPEG-4 content from VoD-W server with IP address and program name.

<!-- this is VoD content from MPEG4 -->

<Stream type="VOD4">

<VODServer>172.17.17.5</VODServer> <!-- vod server ip address or host name -->
<ProgramName>MPEG-4InfovalueVODfile</ProgramName> <!-- vod content name -->
<Location>Complete-Movies</Location><!-- full path for vod content location-->
<Message>MPEG4 content on Infovalue</Messages> <!-- local message -->
<Durations>2h 26m 58s</Durations> <!-- vod content duration -->
<Keyword>Mp4 stream</Keywords> <!-- vod content keyword -->
</Stream>

EtherneTV Media Distribution System



Chapter 4

System Upgrade

Topics in this chapter

Upgrading from v3.71 or Higher

Ubpgrading from v3.70 or Lower

Additional Upgrade Steps for L.ocal Mode

Upgrading from v3.71 or Higher

Note If you are upgrading from version 3.7.1 or higher, it is recommended that you use
the following procedure to update the set top box. You can use the procedure
described elsewhere for older versions but this method is faster and easier.

STB upgrades for set top boxes running v 3.7.1 and higher are performed using the
standalone VBrick download application ETV-STBDownload. With ETV-STBDownload, you
can (1) upgrade a single unit, (2) you can upgrade multiple units in your network using
management SAPs, or (3) you can upgrade multiple units in your network using a manually-
created configuration file. In a typical scenario, you use the setup program provided by
VBrick to (1) install the STB software on an upgrade server and (2) to install the download
application on the same PC or a different PC.

The STB software is installed locally (usually on a machine with ETV Portal Server) and then
uploaded to target STBs using the download application. It is important to note that the
download application needs an FTP server to upload files. An FTP server must be running
on the computer where the release files are located. It can be a third-party FTP server, the
FTP server installed with ETV Portal Server, or the FIP server installed with IIS. For this
reason you may wish to install the application on a machine that is hosting ETV Portal Server
(or on any machine that has I1S installed). If necessary, you can install the download
application first and then configure a remote FTP server later.

Installing the Download Application

You can have multiple Set Top Box software release packages installed on the same server.
Each release is installed in the default location in a separate folder. You can install the
download application and the software release files on the same machine, or on different
machines. During installation, you are prompted to install the STB software, the upgrade
application, or both. The STB software release and the download application can be installed
on any computer running Windows 2000 or higher.

Note You will need the installation disks for your operating system if you do not already
have an FTP server installed.
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v To install STB software and/or the download application:

1. Double-click on setup STB_x_x x.exe in the installer folder to launch the installer.
Then click Next to continue.

EtherneT¥ Set Top Box Software suite - InstallShield Wizard =

Select Features &

Select the features you want to install on your computer.

EtherneT Set Top Box Download application
EtherneTV Set Top Box software ReleazePackage

SelectAl | Claral |

IrnztallShield

< Back | Mest > | Cancel |

2. Select the features you want to install: the Download Application, the Release Package,
or both. Then click Next. (If you select only the Download Application, you will not be
prompted to create an FTP user account as explained below.)

3. Select an installation folder for the Download Application and click Next. The default is
C:\Program Files\VBrick\.

EtherneT¥ Set Top Box Software suite - InstallShield Wizard =

Create user account &

Setup has detected the |15 FTP server and will now create a user account with the username
and password shown, The password is the same as the username

Prezs "Mest' if you would like to create the user account with these parameters
Prezz 'Skip' if you would not like to create the uger account at this time.

If you would like to change the username and password, please enter the desired uzername
and password and press Mest'

If the password is changed from the default, it will have to be entered manually
i the EthermeT-STE Download apolication before starting the unarades.

UszerM ame

Passward

Fie-enter pazsword I

IrztallShield

skp | Newt> |

4. In this scenario, the installer has detected an FTP server and will create a user account.
STBUser is the default name and password for the FTP account. (If you change the
default user or password, you will have to enter them manually each time you run a
download.) Press Next, confirm, and press Next again (or Skip this step entirely if you do
not want to create an FTP account at this time). Note that if an FTP server is not
currently installed on the server machine, you may be prompted for the installation disk.
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5. Select a destination folder for the Release Package and click Next. The default is
c:\inetpub\ftproot\STBUser\Releasexxxx. (All Release Packages have incremental
numbers in separate folders.)

Click Finish when done.

Navigate to Start > All Programs > VBrick > ETV-STBDownload to launch the download
application. On Windows XP, if the download application is blocked and will not launch,
you may need to turn off the Windows Firewall before launching the application. Go to
Start > Control Panel > Windows Firewall.

Before You Begin

Before you begin an upgrade, be aware of the following considerations:

. If the Release Package files (typically inec: \inetpub\ftproot:\STBUser\ReleaseXXX)
are installed on a computer running Windows XP, you must turn off the Windows
Firewall while running the upgrade. Otherwise the upgrade will fail.

*  The download application needs an FTP server running on the computer where the
release files are located. It can be a third-party FTP server, the FTP server installed with
ETV Portal Server, or the FTP server installed with IIS. If you are using the FTP server
installed with IIS and the IP address changes for any reason, make sure you reconfigure
the zew IP address in IIS.

Running ETV-STBDownload

STB upgrades for set top boxes running v 3.7.1 and higher are performed using the
standalone VBrick download application ETV-STBDownload. With ETV-STBDownload, you
can (1) upgrade a single unit, (2) you can upgrade multiple units in your network using
management SAPs, or (3) you can upgrade multiple units in your network using a manually-
created configuration file. Set top boxes running software version 3.7.1 or higher emit
management SAPs. These SAPs identify the presence (and revision level) of all set top boxes
on the network (see Table 1, SAP Information). If you are upgrading multiple STBs, it will
generally take several minutes to upgrade each STB so plan accordingly. Important: When
selecting set top boxes by IP address, be sure fo click in the left column—not on the IP address.
Use Ctrl + Click and Shft + Click to select multiple units.

v To upgrade one or more STBs using ETV-STBDownload:

Be sure all STBs are powered on.
2. Select an Upgrade preference. There are three ways to upgrade your set top boxes.

a. If you select Upgrade using management SAPs, the list is auto-populated. Simply
select the units to upgrade and click Start Upgrade.

b. If you select Upgrade using Configuration file, browse to a configuration file, select
the units to upgrade and click Start Upgrade.

c. If you select Upgrade individual unit, click Start Upgrade and enter the IP address
and password of the unit to upgrade. Click OK to start.
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File Preferences

—Upgrade Sever
IP Addiess |172.22.2.113 Usemame [STEUser Password ===
Path IHeleaseS?E

i Upgrade preference

& Upmgiade using management SAPs

" Upgrade using Configuration file " Uparade individual unit

— Upgrade uzing Configuration file

Configuration File Path I

Browse |

1722216611 Wictors-5TB
1722213624 5SetvSTE
17216.2172  MALCOOD 1026
172221338 kaushik-STE
17222293 WBick-5TE

|P Address | Hostname ‘ Group ‘ Unit | td odel Humber | Fievision | Status ‘ -
| |172225250 McCopSTE 8000-0044-000 0371k Upgrade not started

172162191 MACOO0T 21085 8000-0044-000 0372 Upgrade not started
| 1722Es MACOD0FEE02d 8000-0044-000 0372 Upgrade not started
| |1F2222EE FthDistR ocheste 2000-0044-000 Upgrade naot started
| 1722216611 WICS-OLD-STE 8000-0044-000 0372 Upgrads not started
| 17216260  MACOD01e1088 8000-0044-000 0372 Upgrads not started | |
| 17216253 MACO001e1086 8000-0044-000 0372 Upgrade not started

1721612710 BSBE-5TB G0a-5TE 20 8000-0044-000  03.72 Uporade not started

8000-0044-000 0372 Upgrade nat started
8000-0044-000 Upgrade nat started
8000-0044-000 0372 Upgrade naot started
8000-0044-000 0372 Upgrade naot started
8000-0044-000 0372 Unable to connect to 172.22.2.93 LI

Select All | Clear All | Start Upgrade | Stop | Exit |
IP Address IP address of upgrade server where the Release Package files are
located.
Username Name of FTP account on the upgrade server.
Password Password used to login to the FTP server.

Path

The relative path to the folder in which Release Package files are
located. Enter a relative path for the configured username. Do not
enter an absolute path. (Note that the Release Packages are
numbered incrementally in separate folders.)

Upgrade using
management SAPs

iojxi| Upgrade using the SAP

(Session Announcement

Fleaze enter the password to log in to the Set Top boxes.

Allthe Set Top boxes need to have the same password, PrOtOCOD Cmitted by the

If wou think, zome Set Top boxes have different passwords, . .

pleaze press 'Cancel' and zelect only units which have STB ThlS auwmatlcaﬂy

DL Lkl populates the list box with
Password [y all available set top boxes.

Select individual units and
4| click Start Upgrade. Note
that all STBs must have the
same password. If some are different, the upgrade will fail with a
message in the Status column (see Table 1, SAP Information)

()8 | Cancel |

Upgrade using
Configuration file

Upgrade using a text file that identifies the IP address and the
password used to login to the set top box. This radio button
activates the Configuration File Path field and you can Browse to
a configuration file if available. A sample pipe-delimited
configuration file is shown here:

172.22.133.1|admin
172.22.133.2|admin
172.22.133.3|admin
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Upgrade individual
unit

Upgrade a single unit. Select the
radio button and click Start
Upgrade. A popup will prompt
for IP Address and Password
and automatically run the
upgrade. The password is
/| variable; the username (root) is
fixed and cannot be changed.
Note that all STBs selected for upgrade must have the same
password.

™ individual Unit

Fleaze enter the IP address and the password
of the STE which needs to be upgraded.

IPAddress — [17217.11.111
Iadmin

ok |

=10l x|

Passward

Cancel |

Configuration File Path | Path to a pipe-delimited configuration file. See Editing a
Configuration File on page 31.

Select All Selects all STBs in the list box.

Clear All De-selects all STBs in the list box.

Start Upgrade Starts an upgrade after you selects units to upgrade.

The following table shows the SAP information displayed in the list box for each set top box
when you select Upgrade using Management SAPs.

Table 1. SAP Information

IP Address Set top box IP address.

Hostname The VBrick hostname set in the Configuration: Ethernet >
Management page.

Group The group name the STB is associated with on the Configuration:
Network > Management page.

Unit The Unit Number of the STB on the Configuration: Network >
Management page.

Model Number Set top box hardware model number.

Revision Set top box software revision level.

Status Upgrade status, for example, not started, in progress, failed,

unable to connect, etc.

Once an upgrade starts, do not close the application until the status of all initiated upgrades

changes to Upgrade not needed, Upgrade successful Of Upgrade failed. If you close the
application too soon, the status of some units may not display correctly when the application
restarts. These units may include those which had errors during the upgrade process. The
application can be safely closed after the status of all units has been resolved and you have

corrected any errors.

Editing a Configuration File

You can use a configuration file to identify the units you want to upgrade. A configuration file
is a pipe-delimited text file that identifies the IP addresses and the password used to login to
the set top boxes. (When upgrading with a configuration file, each set top box can have a
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different password.) A sample pipe-delimited configuration file is shown below. You can
create a valid configuration file from a text file by giving it a . cf£g extension.

172.
172.
172.
172.

<

> b=

22.133.
22.133
22.133.
22.133

1|admin

.2 |admin

3|admin

.4|admin

To edit an existing configuration file:

Select Upgrade using Configuration file.

Browse to an existing configuration file and click Open to populate the list box.

Go to File > Edit Config File and use any of the controls to edit the list.
Click save when done.

T EditConfigFile

Set Top Box information
’7IP address

=10l x|

I Passward I

Path

IE:\Documents and Settings'stana\Desklopisam Browse I

£dd Set Top Box to Contig fil |

IF Address | Save |
b [172221331
| 1222132 Select Al |
172221333
| 172221334 Clear Al |
Cloge | %

IP Address Set top box IP address to be added. Click Add Set Top Box to
Config File to add IP address to list box.

Password Password used to login to the set top box.

Path Enter complete path or use Browse to select an existing
configuration (. c£g) file. This file will be written to disk when you
click Save.

Add Set Top Box to Adds specified set top box IP address to the configuration file and

Config File populates the list box.

Logging Upgrade Activities

The ETV-STBDownload application logs all commands and responses between the
application and the upgrade server, and between the application and the set top boxes. To
enable/disable application logging, go to Preferences > Logging. For debugging putposes,
the log file records all error codes, success codes, checksums, etc. Since each new upgrade
overwrites the log, be sure to check the log file (and save if necessary) after a failed upgrade.
The log. txt file is saved by default in: ¢:\Program Files\VBrick\ETV-STBDownload.
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Upgrading from v3.70 or Lower

The upgrade process described here is a two-step process. First you need to create an FTP
server with IIS; then you can actually run the update using a web browser. Also, if you are
using Local mode, you will need to perform the Additional Upgrade Steps for I.ocal Mode on
page 35.

Note If you are upgrading from version 3.7.0 or lower, you must use the following
procedure to update the set top box. You cannot use the procedure described
elsewhere for newer versions of the software.

Creating an FTP Server with IIS

In order to update the set top box code, set up an FTP server in Microsoft I1S to allow the set
top box to retrieve the update files. This example uses the Windows 2000 Operating System.
If using a different Microsoft operating system, refer to the appropriate documentation for
details. Other Linux and UNIX-based FTP servers work equally well.

v To perform a system update using the 1IS FTP server:

1. Go to Start > Programs > Administrative Tools >Internet Services Manager. Then
select from the tree to view selections as described below.

Use the right mouse button to select Default FTP Site.

Select the FTP Site tab.

Set the IP Address.

Select Home Directory tab.

Set Directory Listing Style to Unix. Do not use an @ character in the FTP password.

A A R

Set the Local Path to the FTP home directory. This corresponds to the folder in the
specified location (for example c:\inetpub\£ftproot).

8. Create a subdirectory for the upgrade files in the specified location: Copy the zipped
upgrade to the specified folder (for example, c:\inetpub\£ftproot\etvstb.37xx).

9. Extract the release files from ETV_STB_3_7_xx.tar.gz in the subdirectory created above.
For Windows-based systems, you can use a utility like WinZip. For Unix and Linux
systems, put the above file in the chosen subdirectory and type:

tar xvzf ETV_STB 3 7 xx.tar.gz

Using a Web Browser to Run the Update

Make sure the set top box has a valid IP Address before performing an upgrade. (See Setting
the IP Address on page 4; in the STB configuration program, go to Configuration > Network
> Ethernet > IP Address.)

v To perform a system update using a web browser:

1. Launch a web browser, such as Internet Explorer, and point it to the internal web server
on the set top box, for example http://172.16.135.50 This launches the STB
Administration program.
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f(l) o : “ersion
Administration 03.70r

Log in Systern Infarmation System Time Configuration

You are not logged in

DAl e

10.

Select Login and enter the username and password (the defaults are root and admin).
Go to Configuration > General > System Update.
Select FTP Server and enter an IP Address.

Select Relative Directory Path and enter the path on the FTP server where the upgrade
files are located. This field corresponds to the Home Directory set in the Default FTP
Site Properties. This is a relative directory path and cannot start with a slash.

For example, if the login directory of the FTP user is ¢: \inetpub\ftproot and the
directory containing the upgrade is C: \inetpub\ftproot\etvstb.37xx, enter
etvstb.37xx in this field.

If not set, set the FTP username and password to match the FTP location username and
password. Do not use @ character in the password.

Click Apply and the set top box will perform a partial reset. Wait until the Home page
displays before continuing to the next step.

Select Exit from the STB Configuration menu on the PC.
Go to System Update and click Update.

From the set top box, use the keyboard and enter Ctrl-Alt-F5 to view the upgrade
process. Total upgrade time is approximately 8 — 10 minutes. When done, the STB will
automatically reset to the Home page.

Removing Lock Files

A system update may fail because a "lock" file was detected from a previous update. A lock
file will prevent any subsequent system updates from being successful.

v

1.
2.

"To remove a lock file:

Open a Command Prompt window (see Using the Command Prompt on page 2).

Press Ctrl-Alt-F1 (or Ctrl-L and Enter if necessary to view the command prompt on a
television).

Type cd /var/lock
Type 1s to view the list of lock files.

Type rm systemupdate.LCK (using the appropriate file name).
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6. If only one file is present, just type rm <file names.

Verifying the File Transfer

There are two ways to indicate the progress of the transfer. Once the update is complete, the
Web Administration program shows the version number in the upper right corner. You can
also verify file transfer success using the command prompt:

V¥ To check the version number using the command prompt:
Press Ctrl-Alt-F1 on the set top box.

1
2. Type tasteversion to display the version number.
3

Press Ctrl-Alt-F2 to return to the STB user interface.

Additional Upgrade Steps for Local Mode

The Local mode user interface may have been customized at your site and the upgrade
process does not overwrite the local user interface in order to save your changes. If you use
the local user interface provided by VBrick, and are upgrading an existing set top box, the
system update will not be complete until you perform the following steps.

V¥ To activate all new Local user interface features and functionality, you must perform the
following steps after you finish the upgrade as desctribed above.

1. Gain access to a shell on the box using one of the following methods.
a. Ctrl-Alt-F1 from the keyboard;
b. The serial shell;
c. Telnet.

2. If you want to preserve changes made to the user interface in Local mode, move the files
you have changed (most likely XM and HTM files) to the /wts directory from the /wEs/
localui directory. For example: mv /wfs/localui/stbLocalUIData.xml /wfs

3. Execute the following command rm -rf /wfs/localui
Reboot STB by typing reboot -£

If you did not move any files in Step 2 above, you are done. If you did move files in Step
2 above, continue with the following steps.

Since you may have lost the shell on reboot, regain shell access.
Note that the /wfs/localui directory once again exists.

For each file moved to /wts in Step 2 above, move the equivalent file now in /wfs/
localui to its name with a _build37xx suffix added. These files can be examined for
model code on how to implement new features. For example:

mv /wfs/localui/stbLocalUIData.xml /wfs/localui/stbLocalUIData.xml build37xx

8. For each file moved to /wEs in Step 2 above, move it back into the /wfs/localui
directory. For example: mv /wfs/stbLocalUIData.xml /wfs/localui
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Chapter 5

Serial Port Passthrough

Overview

Using serial port passthrough, STBs can provide full duplex, end-to-end transparent
passthrough of user data from an STB to a VBrick, or to other networked devices. The STB
has one serial port that can be used for passthrough. The setial port operates at its configured
baud rate (e.g. 300 to 115.2 Kbps). Some common applications include remote control of a
camera (pan-tilt-zoom), remote control of security doors, low speed data transport, or data
collaboration between PCs. Note that passthrough mode is used to send control information from
an STB to/ from another device and may not support sustained data at higher data rates.

e —

CoM 1 1 com 1

“ RS 232 Camera

Controller Data

RS 232 Camera
Controller Data

Topics in this chapter
Overview

How Passthrough Works
Using Telnet

How Passthrough Works

VBrick STBs can receive data on a particular TCP/IP port and transpatently output that data
to a serial port. Conversely, any data input to a serial port can be passed through to other
devices connected to that TCP/IP port. Devices include VBrick appliances ot special
applications connected to the appropriate TCP/IP port. This feature is called "Serial Port
Passthrough." The setial port is assigned port TCP 4439. A typical application is for two
VBricks connected to each othet's TCP/IP port 4439. In this case, characters typed into a
terminal program attached to one VBrick's serial port appear on a terminal program attached
to the other VBrick's serial port. In this case, the TCP/IP network serves as an intermediary
between the serial ports of two VBrick appliances.

An STB is a Responder of passthrough connections. When configured as a responder it will
accept up to 64 connections from initiator appliances. It is possible to Disable Passthrough
Mode, so that the STB cannot respond to Passthrough requests. Since the medium used for
setting up Passthrough connections is a generic TCP/IP port, any IP device that is prepared
to connect to a VBrick's port can be considered as a Passthrough Initiator. The VBrick
Responder appliance will not know the exact nature of the device at the other end of the port.
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For example, a generic Telnet client configured to connect to an STB on port 4439 will cause
the STB to start sending data from it's serial port, using the connection it accepted from the
Telnet client.

Note Once a Passthrough connection is established, the actual flow of data is symmetric
between the ends of the connection. That is, the behavior of the serial ports with
respect to typed characters will appear to be the same at both ends, Initiator and
Responder.

Serial Port Pinouts

The serial port on the STB can be used for device management or for the passthrough
responder feature. The pinouts on the serial port are listed below:

Pin Function

—_

N/A

RD - Receive Data

TD — Transmit Data

DTR — Data Terminal Ready

Ground

DSR — Data Set Ready, not used

RTS — Request to Send

CTS — Clear to Send, not used
N/A

O | 0| X | O AW

The RTS and DTR pins can be configured to be always asserted, never asserted, or "auto."
When configured for auto, the control leads are asserted when a passthrough initiator has
established a connection to the passthrough port and de-asserted otherwise. The STB does
not use hardware flow control, so pins 6 and 8 (DSR and CTS) are not used. A null modem
DBY cable (not included) with two female connectors can be used to connect the STB's serial
port to a PC.

Using Telnet

38

As noted, the serial port can be accessed over Ethernet via a Telnet client. An STB configured
as a Passthrough Responder will accept a connection request to TCP port 4439. The request
can come from a Telnet client or other PC application. Any data sent by the PC to TCP ports
4439 will be delivered out of the STB serial port and any data present on the STB serial port
will be sent to the connected PC.

If multiple Telnet sessions are active on one STB (each STB supports up to 64 sessions), the
data from the STB will be sent to all connected PC's, and the data received by the STB from
the PCs will be delivered on the serial port. If multiple Telnet sessions are active and each is
sending data to the STB, the data delivered by the RS-232 port will be a mix of characters
presented in the order they were received (e.g the data from all the senders is bridged
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together). This feature provides a method to broadcast alarm status or other information to
multiple locations.

% Standard Windows
¥ P Telnet
Full duplex RS-232 Port for: \_‘
- Camera Control b
- Alarm Monitoring i g

- Data Collection
- Remnte Contral
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Chapter 6

Using the Set Top Box

Overview

The look-and-feel of the STB screen depends on how it is configured. Once configured with
an IP address and powered on, the set top box opens in one of three Start modes depending
on how it is set to operate. Each Start mode has a different "start" page that is displayed at
startup. To configure Start mode in the STB configuration application, go to Configuration >
Video > Setup > Start Mode.

Start Mode Description

Local In Local start mode, the start page shows all live streams and videos
that are available for viewing. This page is created and programmed by
a system administrator and can be customized or re-created with any
look-and-feel appropriate for your site. Any live streams or videos are
pre-programmed in advance. See Local Configuration on page 21 for
details.

Local-Fullscreen | In Local-Fullscreen start mode, the STB is programmed to display a
single stream or a video. It can only be changed by a system
administrator. There are no user controls except Volume and Mute.

MCS In MCS start mode, the start page is downloaded from a VBrick ETV
Portal Server (formerly MCS). The live streams and videos displayed
on the STB are configured in the Portal Server. See the ETV” Portal
Server Administrator Guide and the ETV” Portal Server User Guide for
more about how to configure and use the ETV Portal Server.

Topics in this chapter

Overview
Start Mode
Using the IR Remote

Using the Wireless Keyboard
Accessing the Web

Start Mode

Local Mode

If the set top box is configured for Local mode, the start page (stbLocalUITemplate.htm) is
stored locally in the STB. The content available on the page (links to either live streams or
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stored videos) is determined and programmed by an administrator and downloaded to the
STB (see Local Configuration on page 21 for more about how to create and download the
configuration file). The page is hard-coded with links to different content. To change the
available content, you need to modify and download a new page.

EthernelV*

MEDIA DISTRIBUTION SYSTEM

«

BSB-Martinez-200khi-1HR MESSAGES

Gl

BSB-Martinez-128khi-1HR

MPEG?2 multicast

Figure 1. Local Mode

Local-Fullscreen Mode

If the set top box is set up in Local-Fullscreen mode, there will be a (live or stored) video
image on the TV at system startup. The image is controlled by the system administrator. It
covers the entire screen and there are no user controls shown or available. The video image is
programmed to decode a specific stream. Volume and Mute are the only controls available
from either the wireless keyboard or the IR handheld remote control.
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Figure 2. Local-Fullscreen Mode

MCS Mode

In MCS start mode, the start page is downloaded from a VBrick Media Control System. The
live streams and videos displayed on the STB are configured in the ETV Portal Server
(formerly MCS). In MCS mode, the STB has optional login authentication to protect against
unauthorized use. If authentication is enabled, the STB will display a login window when
powered on for the first time. You must use the IR remote control (or the wireless keyboard)
to enter a PIN. PIN numbers are configured in ETV Portal Server. Once logged in, the set
top box displays a home page. The home page resides on the ETV Portal Server as an HTML
page and is uploaded to the STB at startup (the ETV Portal Server is a web server). The home
page is dynamically updated with a list of live streams or stored videos. See the ETV Portal
Server Administrator Guide for complete details.

Note The VBrick ETV Portal Server (formetly MCS) is outside the scope of this
document. For more about how to configure and use the portal server, see the
ETV Portal Server Administrator Guide and the ETV Portal Server User Guide
respectively.
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| Qrak ~ - [4] &) 0| & || address [&] hetpijjirz 22.2. 75/, aspx =l

VBrick Systems

Watch Television

Figure 3. MCS Mode

Using the IR Remote

The remote control unit is an infrared remote control device you point at the sensor o7 zhe
front of the STB above the LEDs. As described below, the buttons on the remote control only
work if the STB is configured for MCS or Local mode. If configured for Local-Fullscreen,
you can only use the Volume and Mute buttons. See Start Mode on page 10 for more
information. The buttons on the handheld IR remote control are described in the following
table from left to right and top to bottom.

Note If playing a file on an NXG VOD server in Local mode, the Play button on the IR
remote will start (or re-start) the video from the beginning. For best results, use the
Channel and Select buttons rather than the mouse controls.
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Stop, Play, Pause

Once a stream is selected, the buttons across the
top can be used to stop, play, or pause a video. Stop
and pause are useful when playing VoD streams.

Power

Power the STB on or off.

Begin/End

The outer buttons on the second row are not used.

Fast Forward/
Rewind

The middle buttons on the second row are used
with VoD to go Fast Forward or Rewind MPEG-1
and MPEG-2 videos; not supported with MPEG-4.

Left Mouse Button

Green. Corresponds to left mouse button.

Cursor Pad Press circular pad to move the cursor in the same
manner as you move a mouse.

Right Mouse Button | Black. Not used.

Help Not used.

Up/Down Arrows | Page up and down menus.

Info Provides useful information about a live stream or a
video in progress. MCS Start Mode only.

Mute Mute/un-mute the sound.

Select Yellow. Selects the currently highlighted stream or
menu selection.

Volume Adjust volume up or down.

Full Screen

Press for Full Screen; press again to close.

Channel Press up or down to page through streams or
videos.

aY Opens Watch Television page. MCS Start Mode
only.

WWW Launches a web browser if enabled.

VOD Opens Video on Demand page. MCS Start Mode
only.

0-9 Use to enter a PIN if security is enabled.

Record Red. Press once to start recording if ETV Portal
Server and video-on-demand servers are present;
press again to stop recording.

Menu Displays the Menu commands.

Using the Wireless Keyboard

The wireless keyboard is an optional device. It has an infrared transmitter you point at the
sensor o the front of the STB above the LEDs. It is easy to use the wireless keyboard for any
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STB operation like navigation, selecting streams, etc. It has all of the handheld IR controls
(see above) as well as a full QWERTY keyboard with a mouse pad on the right and mouse
buttons on the left. The wireless keyboard is available from VBrick. When using a standard
keyboatd, it also helps to connect a standard (USB or PS/2) mouse to the STB. Once
attached, go to General > Hardware > Mouse Type to configure the STB for the mouse you
are using. Note that the STB has one PS/2 port and two USB ports.

Accessing the Web

46

The WWW feature requires a keyboard and operates in MCS and Local mode only. Attach a
standard (USB ot PS/2) keyboatd or use the wireless keyboard available from VBrick
Systems. (When using a standard keyboard, it also helps to connect a mouse. To configure a
mouse, go to General > Hardware > Mouse Type.) The WWW feature must be enabled in STB
configuration. To check, go to Configuration > General>Security>Enable Browsing. If
browsing is enabled, select the WWW button on the keyboard or on the IR remote to launch

an Internet browser.

When you select WWW, a browser address bar is displayed at the top left of the window with
navigation buttons on the right. Enter a web location (either an IP address or URL) in the
box provided. Use the IR remote control or wireless keyboard mouse to position the cursor at
the beginning or end of the text string and enter a location with the keyboard. Use Delete or
Backspace to erase. The browser navigation buttons are described below from left to right.

% VBrick Systems

DELIVERIMG & MAMAGIMG WIDED OVER IP METWORKS

1), Search | Library | Hews |

HOME COMPANY PRODUCTS SOLUTIONS ALLIANCES RESELLERS SUPPORT

A I I>|Iz
Icon Description

Back Move back one page.

Forward Move forward one page.

Stop Stops the current operation, for example a page download.
Refresh reloads the current page.

Search Launches a search window, for example Google.
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Icon

Description

Home

Local and MCS mode only. Exits to the home page. In Local mode, it
exits to the local home page; in MCS mode, it exits to the MCS home
page. After returning to the normal STB user interface, press WWW
again to hide the browser address bar.
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